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Author Questionnaire  
 

1. Microscopy: Does your protocol involve video microscopy, such as filming a complex 
dissection or microinjection technique?  N   

 

2. Software: Does the part of your protocol being filmed demonstrate software usage?  Y 

 

3. Filming location: Will the filming need to take place in multiple locations (greater than 
walking distance)?   N 
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Introduction 
 

1. Introductory Interview Statements 
 

REQUIRED:  

1.1. William Ojemann: This protocol is significant to the neural engineering field because it 
offers a concise, unimodal procedure designed to enhance the precision and safety of 
neurosurgery in non-human primates [1]. 

 
1.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, 

looking slightly off-camera  
 
REQUIRED:  

 
1.2. William Ojemann: This technique offers researchers the unique ability to visualize 

every aspect of their implantation or injection procedure and ensures they can enter 
an operating room as prepared as possible [1]. 

 
1.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, 

looking slightly off-camera 
 

OPTIONAL:  
 

1.3. Devon Griggs: Visual demonstration of this method is critical because it highlights the 
impact and clarity that life-size physical models can have on surgical planning [1]. 
 
1.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, 

looking slightly off-camera 
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Protocol 

2. Brain Extraction 

2.1. To extract the brain, in the magnetic resonance imaging software [1], open the Plugins 
dropdown menu and select Extract Brain [2]. 

2.1.1. WIDE: Talent loading image, with monitor visible in frame 

2.1.2. SCREEN: 2.1.2/2.2.1: 00:00-00:04 

2.2. Set the extraction intensity threshold to 0.5-0.7 and the threshold gradient value to 0 
[1]. 

2.2.1. SCREEN: 2.1.2/2.2.1: 00:05-00:10 

2.3. After creating a bitmap of the brain image [1], select Image and Build Surface and 
input the threshold used to extract the brain [2]. 

2.3.1. SCREEN: 2.3.1: 00:16-00:21 

2.3.2. SCREEN: 2.3.2: 00:00-00:08 

2.4. Then click OK to create the surface [1] and save the extracted brain region of interest 
as a .nii or .nii.gz file [2]. 

2.4.1. SCREEN: 2.3.2: 00:11-00:21 Video Editor: can speed up 

2.4.2. SCREEN: 2.4.1 Video Editor: can speed up 

3. Brain Modeling 

3.1. To generate a brain model, open the extracted brain file in the appropriate medical 
image processing software [1] and, in the Editor module menu, select Threshold 
Effect to adjust the threshold range sliders so the portion of the bitmap containing the 
brain is highlighted in all three slices [2]. 

3.1.1. WIDE: Talent opening file in software, with monitor visible in frame 
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3.1.2. SCREEN: 3.1.2 Video Editor: please speed up 

3.2. Open the Model maker module and, in the Input volumes dropdown menu, select the 
bitmap file [1]. 

3.2.1. SCREEN: 3.2.1: 00:00-00:14 Video Editor: can speed up 

3.3. Under Models, select Create New Model Hierarchy and click Apply to create the 
volume [1]. 

3.3.1. SCREEN: 3.3.1: 00:00-00:17 

3.4. When the imported mesh brain surface has been imported, select Graphic 1 [1] and 
suppress any unnecessary graphic features until only the features containing the brain 
are remaining in the file [2].  

3.4.1. SCREEN: 3.4.1_and_3.4.2_HighRes: 00:27-00:33 

3.4.2. Added: SCREEN: 3.4.1_and_3.4.2_HighRes: 00:33-01:05 Video Editor: please 
speed up 

3.5. Then save the file in .prt format for further manipulation and as a .stl for 3D printing 
[1]. 

3.5.1. SCREEN: 3.4.1_and_3.4.2_HighRes: 01:05-01:16 

4. Brain Molding 

4.1. For brain molding, load the extracted brain model into an appropriate computer aided 
design software program [1].  

4.1.1. WIDE: Talent loading file, with monitor visible in frame 

4.2. Under the features section of the Insert menu, select Convert to Mesh body and the 
Graphic body of the brain to convert it and open the Sketch tab and click Sketch to 
select the top plane as the sketch plane [1].  

4.2.1. SCREEN: Section_4_HighRes: 00:23-00:32 
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4.2.2. Added SCREEN: Section_4_HighRes: 01:02-01:24 

4.3. Draw a rectangle around the entire hemisphere of interest [1] and select the extrude 
boss-base feature to extrude a cubic rectangle containing the top part of the brain [2]. 

4.3.1. SCREEN: Section_4_HighRes: 01:32-01:49 Video Editor: can speed up 

4.3.2. Added SCREEN: Section_4_HighRes: 01:53-02:32 Video Editor: please speed up 

4.4. Under the features section of the Insert menu, select Convert to Mesh body [1] and 
select the extruded cube in the Solid bodies folder to convert it [2]. To create the 
negative space, use the Combine feature and select the Subtract option to subtract 
the model of the brain from the newly extruded cube [3]. 

4.4.1. SCREEN: Section_4_HighRes: 02:34-2:43 

4.4.2. Added SCREEN: Section_4_HighRes: 02:44-02:50 

4.4.3. Added SCREEN: Section_4_HighRes: 02:57-03:27 Video Editor: please speed up 

5. Skull Modeling 

5.1. For skull modeling, import the QUICK MP RAGE (quick M-P rage) MRI into an 
appropriate matrix manipulation software program DICOM (die-com) file [1-TXT] and 
use the commands to combine all of the frames into a single 3D matrix as necessary 
[2]. 

5.1.1. WIDE: Talent importing file, with monitor visible in frame TEXT: MPRAGE: 
magnetization-prepared rapid acquisition with gradient echo  

5.1.2. SCREEN: Section 5_6: 00:04-00:09 

5.2. Ensure that each 2D frame of the matrix displays a coronal slice [1] and use a greater 
than operator for individual pixel values to threshold the 3D matrix to create a binary 
mask [2]. 

5.2.1. SCREEN: Section 5_6: 00:12-00:30 Video Editor: please speed up 

5.2.2. SCREEN: Section 5_6: 00:32-00:54 Video Editor: please speed up 
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5.3. Then adjust the threshold such that the skull anatomy is captured by the mask [1-
TXT]. 

5.3.1. SCREEN: Section 5_6: 01:05-01:40 Video Editor: please speed up TEXT: See 
Supplemental coding file CalibrateMask for full adjustment details 

5.4. To remove the “musculature” layer, iteratively grab a 2D slice from the mask to 
process each frame from the 3D mask separately and use the tilde operator to invert 
the values of the mask. The Skull values will be 1’s and the Outside and Brain will have 
values of 0 [1]. 

5.4.1. SCREEN: Section 5_6: 01:50-02:46 Video Editor: please speed up 

5.5. Add additional empty voxels to the 3D mask until the lowest resolution dimension of 
the mask is larger by a factor defined by the scale factor [1-TXT] and linearly 
interpolate values in the mask until the mask fills the new space [2]. 

5.5.1. Talent adding voxels to mask, with monitor visible in frame TEXT: See 
Supplemental coding file “ScaleMask” for more mask resolution details 

5.5.2. Talent interpolating values 

5.6. Then export the skull as an .stl file or similar filetype for 3D printing [1]. 

5.6.1. Talent at computer, exporting skull, with monitor visible in frame 

6. Craniotomy Creation and Agarose Molding 

6.1. To create a craniotomy in the 3D skull model, open the MRI file [1] and manually scan 
back and forth through the 3D matrix to identify the approximate location of the 
craniotomy using anatomical landmarks found in the macaque brain atlas [2]. 

6.1.1. WIDE: Talent opening file, with monitor visible in frame 

6.1.2. SCREEN: Section 5_6: 02:54-03:35 Video Editor: please speed up 

6.2. To create an agarose mold, pour agarose solution into a full or half-hemisphere brain 
mold [1] and allow the solution to solidify within the mold for about 2 hours [2]. 
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6.2.1. Talent pouring solution into mold Videographer: Important step 

6.2.2. Talent setting timer, with mold visible in frame Videographer: Important step 

6.3. When the agarose has set, use a spatula to gently remove the gel model from the 
mold, taking care not to damage the surface of the mold [1].  

6.3.1. Model being removed Videographer: Important/difficult step 

7. Agarose Gel Model Injection 

7.1. For a mock infusion of the agarose gel model, mount a syringe pump onto a 
stereotaxic arm on a stereotaxic frame [1] and fill a 250-microliter syringe with 
deionized water [2]. 

7.1.1. WIDE: Talent filling syringe Videographer: Important step 

7.1.2. Talent loading syringe onto pump Videographer: Important step 

7.2. Load the syringe onto the syringe pump [1] and completely fill the injection cannula 
with the water [2]. 

7.2.1. Talent loading syringe 

7.2.2. Cannula being filled with water 

7.3. Use the pump driver to load the target volume of food coloring for injection into the 
syringe [1] and eject the food coloring until a small bead forms at the tip of the 
cannula [2]. 

7.3.1. Dye being aspirated 

7.3.2. ECU: Dye being ejected/bead forming 

7.4. Dry the bead from the cannula tip [1] and position the gel model under the cannula 
[2]. 

7.4.1. Bead being wiped 
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7.4.2. Model being positioned 

7.5. Lower the cannula until the tip touches the surface of the gel model [1] and note the 
measurements on the stereotaxic arm [2]. 

7.5.1. Cannula being lowered 

7.5.2. Shot of measurements Video Editor: Use second part of shot for this step 

7.6. Then smoothly and quickly lower the cannula into the gel model to the target injection 
depth [1], making sure that the surface of the gel has sealed around the cannula [2], 
and run the pump [3] while observing the spread of the dye until the target volume 
has been delivered [4]. 

7.6.1. Cannula being lowered Videographer: Important/difficult step 

7.6.2. ECU: Shot of gel sealed around cannula Videographer: Important/difficult step 

7.6.3. Talent starting pump  

7.6.4. Shot of dye spreading within model Videographer: Important/difficult step 
Video Editor: Use closeup for beginning, then medium shot, then closeup from 
tailend to demonstrate spread of dye 
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Protocol Script Questions 

A. Which steps from the protocol are the most important for viewers to see?  
6.2., 6.3., 7.1., 7.6.  

 

B. What is the single most difficult aspect of this procedure and what do you do to ensure 
success?  
6.3., 7.6. Success in these steps requires careful manual manipulation as the agarose gel is 
sensitive to tearing and deformation in the extraction from the mold. This is particularly 
important for injection, where a seal between the inserted cannula and the gel brain is required 
for the spread of the dye in the target volume. 
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Results 
8. Results: Representative Neurological Planning Using Nonhuman Primate Brain Models  

 
8.1. Using this protocol, an anatomically accurate physical model of the non-primate brain 

can be created [1]. 
 
8.1.1. LAB MEDIA: Figures 1C and 1D 

 
8.2. Similarly, an anatomically accurate physical model of the primate skull extracted from 

magnetic resonance images can also be generated [1]. 
 
8.2.1. LAB MEDIA: Figure 2E  
 

8.3. The physical models of the skull and brain can be combined with a tight interference 
fit [1], validating the accuracy of the two models relative to each other and 
legitimizing the extrapolated MRI analysis data [2]. 
 
8.3.1. LAB MEDIA: Figure 3A 
8.3.2. LAB MEDIA: Figure 3B 

 
8.4. The insertion of a craniotomy into the skull [1] prior to printing allows combination of 

all of the parts of the sample interface [2] for evaluation of the geometry of the 
various components in relation to the skull and brain [3]. 
 
8.4.1. LAB MEDIA: Figure 3A Video Editor: please emphasize craniotomy in skull 
8.4.2. LAB MEDIA: Figures 3C and 3D Video Editor: please emphasize Figure 3C 
8.4.3. LAB MEDIA: Figures 3C and 3D Video Editor: please emphasize Figure 3D 

 
8.5. For example, in this experiment, the feet of the head post were manipulated and 

fitted to the curvature of the skull at the location of the implantation prior to the 
procedure [1], resulting in a reduced surgical time from approximately 2.5 hours to 1 
hour from opening to implantation, greatly reducing the risk of operative 
complications [2]. 
 
8.5.1. LAB MEDIA: Figure 3E Video Editor: please emphasize implant 
8.5.2. LAB MEDIA: Figure 3E 

 
8.6. Agarose mixture brain models [1] can be injected with yellow dye in an area of 

interest to estimate the volume of the proposed infusion [2] and combining the 
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agarose model with a 3D printed skull [3] can be used to model viral vector injection 
surgery [4]. 
 
8.6.1. LAB MEDIA: Figure 4D Video Editor: please emphasize left model 
8.6.2. LAB MEDIA: Figure 5A bottom right image Video Editor: please emphasize 

yellow dye 
8.6.3. LAB MEDIA: Figure 5B  
8.6.4. LAB MEDIA: Figure 5C 
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Conclusion 
9. Conclusion Interview Statements 

 
9.1. Devon Griggs: Taking into account the variations in skull and brain anatomy in 

different animals, the success of the extraction process will require adjustments in the 
iterative steps [1]. 
 
9.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, 

looking slightly off-camera (2.5., 5.3.)  
 

9.2. William Ojemann: This toolbox can be used to reduce risk in non-human primate 
neurosurgery and the fabrication techniques can enhance the experimental process at 
the cutting edge of neuroscience [1]. 

 
9.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, 

looking slightly off-camera   
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